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This is the age of computers. Computer is undergoing rapid 
change, and new and improved technological advances appear 
almost daily. Computers have invaded all walks of life to such an 
extent that computer literacy has become the order of the day.  
Computer  science is now an essential addition to the school curriculum at all 
levels. 

Computer Zone is a series of ten books on Computer Science for school level, 
designed for the new generation of students who need to acquire knowledge 
on the theory, application and programming aspects of computing. Logical 
and scientific in its approach, the series covers the history of computer, its 
accessories, applications and programming in a step-by-step and graded 
manner. It has been prepared to focus on creativity and encourage young 
children to explore and experiment with learning opportunities.

This book is the four in the series and is recommended for use in class 4. 
The chapters are supplemented with lucid illustrations, practise exercise, brief 
summaries and a variety of theory and lab exercises, that ensure mastery 
over the concepts learnt.

A lot of research and meticulous attention to detail have gone into the making 
of this book. However, there is always scope for improvement. Constructive 
criticism and suggestions which could be incorporated in the future editions of 
this book, are welcome in  my mailing address hari99_sapkota@yahoo.com.

I earnestly hope that the students would find the journey through this series 
an enjoyable experience and gain a sound working knowledge on the 
basic aspects of computing that lay the foundation for good and systematic 
programming. 

-Author
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•	 Define computer and explain how computers compute.
•	 	Explain the special features of a computer.
•	 	Explain the application areas of a computer.
•	 	Identify the various tips for safe computing.

Chapter1
Computers
Knowledge

Learning Objectives

An  Overview

Computers have become a part of everyday 
life. It plays an essential role in how 
individuals work, live and learn. It touches 
the every aspect of our life making it easier 
and comfortable. These days computers are 
the tools for not only engineers and scientists 
but also they are being used by millions of 
people around the world. Computer has 
become very important nowadays because 
it is very much accurate, fast and can 
accomplish many tasks easily.
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Define Computer

The word computer is derived from the Latin word “Computare” 
which means “to calculate”. A computer is an electronic machine 
which accepts data as input and processes it to provide information as 
output. It has a large memory to store data and information. It carries 
out calculations and other processes by following a set of instructions, 
called the program. 

Monitor CPU Tower

Mouse

Keyboard

expanding 
your horizons

Laptop computers, also known as notebooks, are 
portable computers that you can take with you and use 
in different environments. They include a screen, keyboard, 
and a trackpad or trackball, which serves as the mouse. 
Portable computers run off AC power and also have the ability to run. 

In June 2007 Asus announced the Eee PC 701 to be 
released in October, a small lightweight x86 Celeron-M 
ULV 353 powered laptop with 4 GB SDHC disk and a 7” 
inch screen.
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How do Computers Compute?

A computer is a machine that works according to commands or 
instructions that we give. A set of instruction is called a program.  A set 
of one or more programs is called software. A computer performs four 
basic operations. They are:

Input
The data and instructions entered into the computer is called input. 
Input is supplied to the computer with the use of a keyboard, a mouse 
or other input devices.

Processing
Processing is the conversion of input into output. Processing is done 
inside the computer in the Central Processing Unit (CPU).

Storage
Storage refers to the saving of information for later use. Storage is done 
in the memory of a computer. There are many storage devices such as 
pen drives, hard disks, optical disk, etc.

Output
Output is the result produced by a computer. Output may be viewed on 
a monitor screen, heard through speakers, printed through printers on 
paper or stored in the memory for later use.

Input Processing Output

Storage

Feedback
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Special Features of a Computer

We are living in the age of electronic 
revolution where computers are integral 
part of our life. It is indeed, difficult to 
imagine our daily life without their use in 
one way or other. Practically, computers 
have entered into each and every walk of 
life due to the following special features of 
computers: 
Speed
A computer is a very fast device. It can solve numerous problems within 
seconds. It can process millions of instructions per second. As the power 
of computer increases, the speed also increases.

Accuracy
Computer is a very accurate machine. It never makes mistakes in 
calculations. If input value and set of instructions are correct, the result 
produced will be correct. If the input is incorrect the output is also 
incorrect. This is known as GIGO (Garbage In Garbage Out).

Large Memory
Computer has a large memory. It can store a large amount of data in its 
memory. It is easy get the information from them in seconds.They can 
store large amount of data and information in the secondary memory.

Diligence
A computer can work for a long time. It never feels bored and tired, 
unlike human beings. It can work for long hours continuously. It can 
also do the same work repeatedly.
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Brainstorming 

  task

Versatility
Computers are versatile machines, which can handle a large variety of 
jobs. They are used in all areas of modern life-in science, technology, 
business, industry, leisure and entertainment.

Reliability
Computer provide very high speed accompanied by an equality high 
level for reliability. Thus computers never make mistakes of their own.

No intelligence
A computer is a magical device. It can only perform tasks that a 
human being can. The difference is that it performs these tasks with 
unthinkable speed and accuracy. It posses no intelligence of its own. Its 
I.Q is zero at least till today. It can only perform what is programmed 
to do. Hence, only the user can determine what tasks a computer will 
perform. Computers have no sense of meaning, cannot perceive and are 
only able to make simple robotic decision about the data they receive.

Answer the following questions.
a.	 What do you understand by “Computare”?
b.	 What is a program?
c.	 Why is laptop computer also called notebook?
d.	 Why is computer called diligent machine?
e.	 List any three special features of a computer?
f.	 Draw a block diagram of a computer system.
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Application areas of a Computer

Computers are very productive and efficient. It has great impact on every 
aspect of mankind and plays an important role in our society. Due to the 
computer technology the world become like a global village, people 
can share each and every information with in a second with a very low 
cost. In present the application area of a computer is countless. In each 
and every field computers are used to do various types of works. Some 
of the application areas of computer are:

Computers in Schools
Computer is used by teachers for making 
lesson plans, for teaching different topics 
related to the subject using CDs and for 
making report cards. It is also used for 
maintaining records of students and also for 
preparing results. Students use computers for 
making projects and learning different topics 

of a subject.

Computers in Offices
Computers are used in offices for storing 
data. It is easier to maintain records in a 
computer. Important information can be 
communicated via computers. Computers 
are also used to make various presentations 
and reports.

Facts Corner

 Internet-enabled computing allows you to receive orders from 
customers, place orders with suppliers, research businesses, 
explore business ideas,  communicate with government agencies 
and even manage your business’ banking.
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Computers in Medicine
Computers are widely used in the field of 
medicine. Computerized equipments are 
used for medical tests and surgeries in 
hospitals. Furthermore, computers are used 
greatly in managing patients, doctors, wards 
and medicine records, as well as deal with 
making appointments, scheduling surgeries 
and other likes.

Computers in Industries
Computers are widely used in small and big 
industries. Computers are used to monitor 
almost all the operations in most of the 
industries. The use of computer, makes the 
task of finding defects in the jobs/product 
very simple. The quality of product of 
an industry can be ensured only through 
computerised processes of manufacturing.

Computers in Animation
Computer animation is the art of creating 
moving images by the use of computers. In 
fact, it is the illusion of movement which 
is created by displaying a series of pictures 
quickly. To create the illusion of movement, 
an image is displayed on the screen and 
then quickly replaced by a new image that 
is similar to the previous image but shifted 
slightly. Computer which you see are 
possible only through animation.
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Computers in Law and Order
Computers are used by police and 
investigation departments to keep a tab on 
criminals and convicts on the run. Minute 
details of speech intonation, physical 
characteristics, criminal habits and finger 
prints can be matched for accurate detection 
through computers. Lawyers can store 
volumes of cases and judicial proceedings 
in the computer. 

Computers in Airline Reservation
In an airline booking system, most airlines 
have booking offices all over the world. The 
computer stores details of all setting flights 
and updating information all the time.  In this 
way, enquiries and bookings for different 
flights can be made from different booking 
offices all over the world efficiently.

Computers in Entertainment
There are many ways in which computers 
are used in entertainment. With the advent 
of the internet, computers have become the 
means for entertainment such as watching 
shows, movies and videos. Computers are 
also used to play video games and also used 
to play music. Computers are also used for 
creating special effects in a film combined 
with real scenes and characters.



9Computer Zone - Book 4

Tips for Safe Computing

Use a Correct Posture
Make sure you sit up straight in front of your 
keyboard and screen.
Avoid sitting with your feet or legs crossed. 
Your feet should be flat on the ground and there 
should be enough space under the desk/table to 
move your legs freely.
Always remember that your lower arms and 
thighs should be parallel to the ground. If 
possible make ajustments to your chair.

Using the Keyboard
Do make sure that the keyboard is titled on its back legs. It is very 
important that your wrists and fingers should line up directly with your 
lower arms and not be bent as you type.
Remember not to hammer at the keyboard when typing and do not 
overstretch your fingers. 

Using the Mouse
Make sure that you always keep your mouse within easy reach. Wrists 
should not be bent or strained. Heal of hand supported by an appropriate 
mouse mat is often helpful.
Flex your hands and fingers to prevent cramps and aches at regular 
intervals.
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Computer	 :  	 An electronic machine that converts 
data into information using a program.

Input	 ;	 The data and instructions entered into 
the computer.

Processing	 :	 The conversion of input into output.
Animation	 :	 The art of creating moving images by 

the use of computers.
GIGO	 :	 If the input is incorrect the output is 

also incorrect.

Tricky Terms 

•	 Computers are used in banking, most businesses, schools and 
hospitals to name a few because of their accuracy and ease of use. 

•	 A computer is an electronic machine which accepts data as input 
and processes it to provide information as output.

•	 The data and instructions entered into the computer is called input.
•	 Processing is the conversion of input into output.
•	 Storage refers to the saving of information for later use.
•	 Output is the result produced by a computer. 
•	 Computer is a very accurate machine.
•	 Computers are versatile machines, which can handle a large variety 

of jobs.
•	 Computer animation is the art of creating moving images by the 

use of computers.

Let 
Us Revise
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Chapter Review
1.	 Fill in the blanks. Choose the answer from the clue box.

Clue  Box
Speed, computare, output, Animation, Processing

a.	 The word computer is taken from a Latin word __________________.      
b.	 ___________________ is the conversion of input into output.
c.	 The result of your data that you get after processing is called 

____________. 
d	 Computer works at a very high__________________.
e.	 ________________ is the art of creating moving images by the use 

of computers.

2.	 Match each term with the statement that best describes it.
GIGO	   	 An electronic machine that converts data into 

information using a program.
Processing		  The data and instructions entered into the computer.
Animation		  The conversion of input into output.
Input		  The art of creating moving images by the use of 

computers.
Computer		  If the input is incorrect the output is also incorrect.

3.	 Say whether these sentences are True or False.
a.	 Computer carries out calculations and other processes by following 

a set of instructions, called the progam. 
b.	 A set of one or more programs is called hardware.
c.	 Processing is done inside the computer in the storage unit.
d.	 Computers are versatile machines, which can handle a large variety of jobs.
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Extrapolative Exercise

a.	 Make a chart of things which can be done:
	 i. Only by human beings.
	 ii. Only by computers.
b.	 Collect two pictures of any animated cartoon and paste them in your 

scrap book.
c.	 Make a chart to show various places where computers are used which is 

not mentioned in the chapter.
d.	 Visit your school’s office and make a list for what purpose computers are 

used.

4.	 Answer the following questions.
a.		 What is a computer? 
b.	 What is a program?
c.	 What is software?
d.	 Define the terms: 
	 i. Input		  ii. Processing		  iii. Output
e.	 What are the special features of a computer?
f.	 What do you understand by the term ‘GIGO’?
g.		 Why is computer called a versatile machine?
h.	 Why are computers used in banks?
i.	 How do computers help in medicine?
j.	 What is computer animation?
k.	 How are computers useful in airline ticket booking counter?

5.	 Write the full form of the following.
		 GIGO			   CPU		   	  PC			   CD
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•	 Define input device and explain the functions of input devices.
•	 	Explain the different types of keys found in a computer keyboard.
•	 	Define pointing devices and explain their uses.
•	 	Define video input device.

Chapter2
Computer
‘Inputs’

Learning Objectives

An  Overview

Input device is a device used to enter data 
and instructions into the computer. There 
are many different input devices, the most 
common input device is keyboard and a 
mouse. 
The functions of input unit are:
a. 	 accept instructions and data
b. 	 convert these data and instructions to 

the form acceptable to the computer.
c. 	 supply the data and instructions to the 

processing unit of the computer system
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Keyboard is one of the most important input devices of a computer. It 
is a device used for entering data and instructions into the computer. It 
has different keys to perform various operations. The keys have letters, 
numbers and other symbols written on them. Instructions are given to 
the computer by pressing these keys. There are many tasks that you can 
accomplish using a keyboard. You can use it to type your documents, 
access menus, make changes in your documents and much more. 
There are five types of keys on a keyboard. They are: 
•	 Alphabet keys	 -	 Alphabet keys are used for typing text.
•	 Numeric keys	 -	 Numeric keys are used for typing 

numbers.
•	 Function keys	 -	 Function keys are used for special 

functions depending on the program 
used.	

•	 Arrow keys	 -	 Arrow keys are used for moving the 
cursor on the screen. They are marked 
with arrows in four different directions.

•	 Special keys	 -	 Special keys are used for performing 
special tasks. Some of the special keys 
are Enter key, Caps Lock key, Spacebar, 
Delete key and Backspace key.

Keyboard
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A pointing device is an input device used to move the pointer on the 
screen.  The major pointing device is the mouse for the desktop computer 
and the touchpad for the laptop. Some of the other pointing devices are 
light pen, touch screen and joystick.

Pointing Devices

Mouse
The mouse is also an input device. It is a small 
plastic box with buttons on top. There is a small 
wheel called scroll button in the latest mouse. 
The bottom of the mouse is flat and contains 
a mechanism that detects movement of the 
mouse. It is placed on a mouse pad, which 
provides a flat surface for the mouse to roll on.  
It is used to draw pictures on the screen. 

Touchpad
It is one of the latest pointing devices. It has a 
flat rectangular surface of 1.5 or 2 inches square. 
It consists of a soft pad sensitized to finger 
movement or pressure and used especially on 
laptop computers as an alternative to a mouse.

Light pen
Light pen is a light-sensitive pointing device 
shaped like a pen. It has a light sensor fixed at 
the end of a pen-shaped tube. It allows the user 
to point to displayed objects, or draw on the 
screen in a similar way to a touch screen but 
with greater positional accuracy.
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Touch screen
Touch screen is also an  input device. The 
screens are sensitive to pressure; a user 
interacts with the computer by touching 
pictures or words on the screen. The 
touch screen can be used to select the 
options displayed on the screen. They are 
commonly used in hotels, hospitals and 
airports.

Joystick
Joystick is a stick mounted on a circular 
base with buttons on top of the stick. It has 
a lever which can move in any direction.
The joystick is able to move in different 
directions. It is mainly used for playing 
computer games.	

Brainstorming 

  task
Fill in the blanks. Choose the answer from the clue box.

Clue  Box
Mouse, Alphabet, Input, joystick, lightpen

a.	 ________________is a device used to enter data and instructions 
into the computer. 

b.	 _________________ keys are used for typing text.
c.	 ________________is a small plastic box with buttons on top.
d.	 A_________is a light-sensitive pointing device shaped like a pen.
e.	 A ___________________is a stick mounted on a circular base 

with buttons on top of the stick. 



17Computer Zone - Book 4

A video input device is any device that sends video. There are several 
types of video input devices that allow you to play video from an 
external device on a video display. The information can be stored in a 
multitude of formats depending on the user’s requirement. Some of the 
video input devices are digital camera and web camera.

Video Input Device

Digital camera
Digital camera (or digicam for short) is a 
camera that takes video or still photographs, 
or both, digitally by recording images via 
an electronic image sensor. The digital 
camera can be powered by batteries. 
Digital cameras can also be connected to 
a computer to transfer photos and videos.

Web camera
Web camera is attached on the top of the 
computer screen. It allows the user to create 
a movie and take digital photographs. It 
also allows the user to see and talk to a 
person over the Internet.	

Facts Corner

First developed in 1991, a webcam was pointed at the Trojan 
Room coffee pot in the Cambridge University Computer Science 
Department.
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Input device	 :  	A device used to enter data and 
instructions into the computer.

Light pen	 :	 A light-sensitive pointing device 
shaped like a pen.

Joystick	 :	 A stick mounted on a circular base 
with buttons on top of the stick.

Digital camera	 :	 A camera that takes video or still 
photographs, or both, digitally by 
recording images via an electronic 
image sensor.

Tricky Terms 

•	 Input device is a device used to enter data and instructions into the 
computer. 

•	 Keyboard is used for entering data and instructions into the 
computer.

•	 A pointing device is an input device used to move the pointer on 
the screen.

•	 Mouse is an input device that is made up of small plastic box with 
buttons on top.   

•	 Touchpad has a flat rectangular surface of 1.5 or 2 inches square. 
•	 Light pen is a light-sensitive pointing device shaped like a pen. 
•	 Joystick is a stick mounted on a circular base with buttons on top 

of the stick.
•	 Digital camera (or digicam for short) is a camera that takes video 

or still photographs, or both, digitally by recording images via an 
electronic image sensor.

Let 
Us Revise
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Chapter Review
1.		 Fill in the blanks. Choose the answer from the clue box.

Clue  Box
Web camera, mouse, Input, joystick, light pen

a.	 __________________is a device used to enter data and instructions 
into the computer.  

b.	 The_____________ is a small plastic box with buttons on top and a 
scroll button. 

c.	 ___________has a light sensor fixed at the end of a pen-shaped tube.
d.	 A________________is a stick mounted on a circular base with 

buttons on top of the stick. 
e.	 _______________allows the user to see and talk to a person over 

the Internet.	

2.	 Match each term with the statement that best describes it.
Touchpad		  A light-sensitive pointing device shaped like a pen.
Digital camera		  A stick mounted on a circular base with buttons on 

top of the stick.
Joystick		  A camera that takes video or still photographs, or 

both, digitally by recording images via an electronic 
image sensor.

Light pen		  A stationary pointing device that has a flat rectangular 
surface of 1.5 or 2 inches square.

3.	 Say whether these sentences are True or False.
a.	 Input device is a device used to enter data and instructions into the 

computer. 
b.	 Touchpad has a flat rectangular surface of 1.5 or 2 inches square. 
c.	 A touch screen is a stick mounted on a circular base with buttons on 

top of the stick.
d.	 A audio input device is any device that sends video. 
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4.	 Answer the following questions.
a.	 What is an input device? Name two most common input devices.
b.	 What is a keyboard? Name the different types of keys found in a 

keyboard. 
c.	 What is a pointing device? Name any three pointing devices.
d.	 What is a computer mouse? 
e.	 What is a light pen? What does it do?
f.	 What is a joystick?
g.	 What is a video input device? Name some of the video input devices.
h.	 h. What is web camera?

Extrapolative Exercise

a.	 Make a list of latest input devices and explain their 
uses.

b.	 Read the clues and write the names of these input 
devices.

I am used for entering 
data and instructions 
into the computer.

1
I am a light-sensitive 
pointing device shaped 
like a pen.

2

c.	 Search on the Internet and find some more input devices. Write their uses 
.
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•	 Define system unit and identify the different parts of system unit.
•	 Explain the main components present in system unit.
•	 	Define Central Processing Unit and list the functions of CPU.
•	 	Identify the different parts of CPU.
•	 	Define secondary storage device and list its examples.

Chapter3
System
Unit

Learning Objectives

An  Overview

System unit is the most part of a computer 
system. It is a box like case standing 
beside the monitor or kept under the 
monitor. It includes the motherboard, 
CPU, RAM, and other components. The 
system unit also includes the case that 
houses the internal components of the 
computer. It keeps the internal parts of a 
computer safe and protects from outside 
damage or harm. System unit cases can 
come in many different sizes. 
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The motherboard is a large board inside 
a system unit. It is the main circuit board 
containing the primary components of a 
computer system. This board contains the 
microprocessor, RAM, ROM and other 
important components of a computer. It 
can also be called as the “backbone” of 
computer.

Motherboard

expanding 
your horizons

A typical desktop computer has its microprocessor, main memory, and other 
essential components connected to the motherboard. A motherboard is 
sometimes alternatively known as the mainboard, system board, planar board 
or logic board.

The CPU (Central Processing Unit) is the 
most important part of a computer. It is 
the ‘brain’ of the computer. It is the main 
processing unit of a computer where all the 
major decisions are taken and the other parts 
function as directed by it. It processes and 
after processing it displays  information on 
the screen. It works like a bridge between 
input and output devices. It can only carry 
out the instructions programmed into it. It 
is also called the “processor”.

Central Processing Unit
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Functions of CPU
The functions of CPU are listed below:
•	 The main function of CPU is to perform arithmetic and logical 

operations on data.
•	 CPU is used to control the functions performed by the other 

components.
•	 Most of the devices connected to the computer communicate with 

the CPU to perform any task.

The CPU is the most important element of a computer system. It is the 
brain of the computer where most calculations take place. There are 
three components of the CPU that works together to perform different 
processing operations. They are:
a.	 Arithmetic and Logic Unit (ALU)
b.	 Control Unit
c.	 Memory Unit (MU) 
Arithmetic Logic Unit
The Arithmetic Logic Unit performs all the arithmetic calculations 
like addition, subtraction, multiplication and division. It also makes 
comparison of data such as less than, greater than and equal to. 

Control Unit
The control unit is the heart of the computer system. It controls the 
working of all the other parts of the computer. The functions of Control 
Unit are:
a.	 It transfers data from input devices to the primary memory.
b.	 It then passes the data from primary memory to ALU.
c.	 It sends the result from the primary memory to the output devices.

Parts of CPU
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Memory Unit
The data and instructions that are entered into the computer using 
input devices, are to the stored inside the memory unit. Memory unit is 
divided into two storage parts. They are:
a.	 Primary memory
b.	 Secondary storage

Primary Memory
The primary memory is the main memory of a computer. It is the internal 
storage of the computer. It holds data temporarily while computer 
processes it. It is also called the internal memory. 
Primary memory is divided into two types: RAM and ROM. Each type 
of primary memory is used for a different purpose in a computer system.

a.	 Random Access Memory
	 RAM (Random Access Memory) is a 

temporary memory. The user can read 
and write into a RAM. Its contents are 
lost when the power supply is switched 
off. 

b.	 Read Only Memory
	 ROM (Read Only Memory) is a permanent memory. The user can 

read but cannot write into a ROM. Its contents are not lost when the 
power supply is switched off. 

Facts Corner

Early computers used relays, or delay lines for “main” memory 
functions.
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Secondary Storage Devices

Secondary storage devices are the devices that are used to store 
the data and information into the computer. Hard disk, pen 
drives, DVD, Blue-ray disk and CD-ROM are the examples of 
secondary storage media and the device that uses or holds the 
media is known as a secondary storage device.

Hard disk
Hard disk is the main storage 
device of the computer. It is a rigid 
magnetic disk fixed permanently 
within a drive unit and used for 
storing computer data. Hard disks 
generally offer more storage and 
quicker access to data. 

Pen drive
Pen drive is a small, lightweight, 
removable disk. It is very small in 
size and can be carried in a pocket or 
hand like a pen. It is used for storing 
and transferring audio, video, and 
data files from a computer.  It is also 
called thumb drives. 

Facts Corner

 The first IBM drive, the 350 RAMAC, was approximately the 
size of two refrigerators.
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Optical Disk
Optical disk is a disk coated with reflecting 
medium. It is portable and can hold a large 
amount of data. Data is read and recorded 
through a laser beam. The optical disks 
have the capacity to store a large amount 
of data in the form of text, graphics, audio 
and video. CD-ROM (Compact Disk Read 
Only Memory, DVD (Digital Versatile 
Disk) and Blue-Ray disk are the common 
types of optical disks. 

Floppy Disk
Floppy disk is a popular secondary storage 
medium. It is a plastic disk coated with 
magnetic material. It is sealed with a 
protective jacket. A floppy disk is inserted 
into a floppy drive to read data from it or 
write information on it. It is also used to 
transfer small files from one computer to 
another. The most common size is 3.5 inches 
which holds upto 1.44 MB (megabyte) of 
data.

expanding 
your horizons

The Blu-ray format is HD-DVD format that uses a 405nm-wavelength blue-violet 
laser technology, The Blu-ray format was developed jointly by Sony, Samsung, 
Sharp, Thomson, Hitachi, Matsushita, Pioneer and Philips, Mistubishi and LG 
Electronics.
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System unit	 :  	A box like case standing beside the 
monitor or kept under the monitor. 

Motherboard	 :	 The main circuit board containing the 
primary components of a computer 
system.

CPU	 :	 The main processing unit of a 
computer where all the major 
decisions are taken and the other 
parts function as directed by it.

Pen drive	 :	 A small, lightweight, removable disk.

Tricky Terms 

•	 System unit is a box like case standing beside the monitor or kept 
under the monitor.

•	 The motherboard is a large board inside a system unit. 
•	 CPU is the main processing unit of a computer where all the major 

decisions are taken and the other parts function as directed by it. 
•	 The control unit is the heart of the computer system.
•	 RAM (Random Access Memory) is a temporary memory. 
•	 ROM (Read Only Memory) is a permanent memory. 
•	 Secondary storage devices are the devices that are used to store the 

data and information into the computer.
•	 Optical disk is a disk coated with reflecting medium. 
•	 Floppy disk is a plastic disk coated with magnetic material.

Let 
Us Revise
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Chapter Review
1.		 Fill in the blanks. Choose the answer from the clue box.

Clue  Box
CPU, Motherboard, Secondary memory, ALU, Optical disk

a.	 ______________________is the main circuit board containing the 
primary components of a computer system. 	

b.	 ______________________is the brain of the computer where most 
calculations take place.

c.	 The____________________performs all the arithmetic calculations 
and also makes comparison of data such as less than, greater than 
and equal to. 

d.	 ____________________is a permanent memory. 
e.	 ____________________is a disk coated with reflecting medium. 

2.	 Match each term with the statement that best describes it.
Motherboard			  The ‘brain’ of the computer.
Hard disk		  The heart of the computer system. 
Pen drive		  A rigid magnetic disk fixed permanently within a drive unit.
RAM		  A small, lightweight, removable disk.
CPU 		  The main circuit board containing the primary 

components of a computer system. 

3.	 Say whether these sentences are True or False.
a.	  System unit keeps the internal parts of a computer safe and protects 

from outside damage or harm. 
b.	 Motherboard works like a bridge between input and output devices.
c.	 Control unit controls the working of all the other parts of the computer. 
d.	 The user can read but cannot write into a RAM.
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4.	 Answer the following questions.
a.	 What is a system unit? What does it contain?
b.	 What is Central Processing Unit?
c.	 What are the function of Central Processing Unit?
d.	 What are the three different parts of Central Processing Unit?
e.	 What is Arithmetic Logic Unit?
f.	 What are the functions of Control Unit?
g.	 Name two types of primary memory present in a computer.
h.	 What is Random Access Memory?
i.	 What is a secondary storage? Give examples.
j.	 What is an optical disk?

5.	 Write the full form of the following.
	 RAM       	 ROM       	 MU        	 ALU

Extrapolative Exercise

a.	 Visit your computer lab, and try to explore the internal parts of system 
unit and watch how they are attached.

b.	 Name the following devices.

1 2

1 2
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•	 Define output device and explain the functions of output devices.
•	 	Explain the different types of computer monitors.
•	 Define printer and explain the two most commonly used printers.
•	 Define speakers and headsets. 

Chapter4

Learning Objectives

An  Overview

Output device is used to show the result 
after processing inside the computer. 
Some of the common output devices are 
monitor, printer and speaker. 
The functions of output devices are:
a. 	 convert the result produced by the 

computer after processing, into a 
form that we can understand.

b.	 display the converted results with 
the help of the output devices.

Computer
‘Outputs’
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A monitor is an output device looks like a television. It shows the result 
of work done by the computer. It is a soft copy output as it provides 
a temporary display of meaningful information. The front part of the 
monitor is called its screen.The cathode ray tube (CRT), the liquid 
crystal display (LCD) and Light Emitting Diode (LED) are the types of 
monitor available in the market.

Monitor

LCD stands for liquid crystal display.  
It is a flat panel display, electronic 
visual display. The newer, flatter type 
of computer screen.

CRT stands for cathode ray tube. It is the 
traditional, glass-screen, television-set-
like monitor.

LED stands for Light Emitting Diode. 
It is a flat panel display, which uses 
an array of light-emitting diodes as a 
video display.
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A printer is a hardcopy output device used to print the results of work 
done by the computer on paper. It is a hard copy output as it produces 
a printout of the output from a computer. There are different types of 
printers. Dot matrix and laser printers are the most commonly used 
printers.

Printer

Inkjet printer is a computer peripheral 
that produces hard copy by spraying 
ink onto paper. Inkjet printer does not 
make a noise and can produce a good 
printout of both graphics. 

Laser printer is a type of printer that utilizes 
a laser beam to print on paper. It has a toner 
cartridge which contains fine powdered 
black plastic called toner. A laser printer 
offers excellent print quality for text and 
graphics. It also prints at a very high speed. 

Speakers and headsets are the output 
devices that allow the users to hear 
sound output from the computer. They 
can be of different shapes and sizes. 
Computer speakers range widely in 
quality and in price. Some computer 
speakers have equalization features 
such as bass and treble controls.

Speakers and Headphones
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Monitor	 :	 A TV like screen which displays text, 
pictures and videos.

Soft copy	 :	 The output displayed on a monitor.
Printer 	 :	 An output device that gives printed 

output on paper.
Hard copy	 :	 The printed or permanent copy of the 

output. 
Laser printer	 :	 A high-speed printer that uses a laser 

beam to print on paper. 

Tricky Terms 

•	 The device that is used to show the output to the user is called an 
output device. 

•	 A monitor is an output device which resembles a television. 
•	 LCD is a flat panel display, electronic visual display.
•	 LED is a flat panel display, which uses an array of light-emitting 

diodes as a video display.
•	 A printer is a device used to print the results of work done by the 

computer on paper.
•	 An inkjet printer is a computer peripheral that produces hard copy 

by spraying ink onto paper.
•	 Laser printer is a type of printer that utilizes a laser beam to print 

on paper. 
•	 Speakers and headsets are used to listen to the sound being played 

by the computer system. 

Let 
Us Revise
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Chapter Review
1.	 Fill in the blanks. Choose the answer from the clue box.

Clue  Box
Laser, CRT, Printer, Monitor, output  

a.	 The device that is used to show the output to the user is called an 
___________________device.  

b.	 __________________is a soft copy output as it provides a temporary 
display of meaningful information.

c.	 __________________is the traditional, glass-screen, television-set-
like monitor.

d.	 A_________________is a device used to print the results of work 
done by the computer on paper.

e.	 ___________________is a type of printer that utilizes a laser beam 
to print on paper. 

2.	 Match each term with the statement that best describes it.
Laser printer		  A TV like screen which displays text, pictures and videos.
Printer		  The output displayed on a monitor.
Hard copy 		  An output device that gives printed output on paper.
Soft copy		  The printed or permanent copy of the output. 
Monitor		  A high-speed printer that uses a laser beam to print 

on paper.  

3.	 Say whether these sentences are True or False.
a.	 LCD is the traditional, glass-screen, television-set-like monitor.
b.	 A printer is a device used to print the results of work done by the 

computer on paper. 
c.	 An inkjet printer is a computer peripheral that produces hard copy 

by spraying ink onto paper.
d.	 Laser printer is a type of printer that utilizes a laser beam to print on 

paper. 
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4.	 Answer the following questions.
a.		 What do you mean by output?
b.	 What is an output device? Name three common output devices.
c.	 What is soft copy?
d.	 What is the difference between monochrome monitor and colour 

monitor?
e.	 What is a printer? Name the two most commonly used printers.
f.	 What is a dot matrix printer? State any two disadvantages of dot 

matrix printer.
g.	 What is a laser printer?
h.	 What are speakers?

5.	 Write the full form of the following.
	 CRT       	 LCD   	   LED     	    TV

Extrapolative Exercise

a.	 Visit your computer lab, and try to explore the different  types of output 
devices attached to your computer system. 

b.	 Match the following pictures of output devices with their names by 
colouring with same colour in boxes.

Printer

Speakers

Monitor

Headphones

Answer Box
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•	 Explain the importance of operating system in a computer system.
•	 	Identify the important components of Windows Desktop.
•	 	Define Start menu and explain its important elements.
•	 	Explain the steps to personalize Windows 7.

Chapter5

Learning Objectives

An  Overview

Computers need operating system 
software in order to manage resources 
and accept commands from the user. The 
operating system is the glue that makes 
software programs and hardware work 
together. As the name “operating system” 
denotes,  it is what helps the computer 
“operate”. An operating system is an 
organized collection of programs that 
acts as an interface between machine 
hardware and users. Without an operating 
system, you cannot run any program.

More About
Windows 7
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Microsoft Windows 7

Windows is the name of an operating system developed by Microsoft 
Corporation, USA. The Windows operating system helps the user to 
operate and control the overall activities of a computer. Windows has 
many versions that regularly get updated with time and requirements. 
Some versions are Windows 98, Windows XP and the recent Windows 
7.
Windows 7 is a Graphical User Interface (GUI) in which all the items 
are represented in the form of pictures and graphical links.  When you 
switch ON your computer, Windows 7 gets loaded automatically. 
a.	 Switch ON the main power supply button.
b.	 Switch ON the power button on the UPS.
c.	 Switch ON the power button on the CPU.
d.	 Switch ON the power button on the monitor.	
e.	 Type the password and press Enter key. Windows 7 desktop will 

appear.

Facts Corner

Windows 8 is a personal computer operating system developed 
by Microsoft.
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Desktop

The first screen you see when the operating system (Windows) has 
finished loading, is known as desktop. It remains in the background for 
all the time.
Some of the features of desktop are:
a.	 It is where all the icons of different applications exist.
b.	 It is the home for all shortcuts. Programs can be quickly opened by 

clicking the respective shortcuts.
c.	 It holds various information such as time, date, etc.

Icon

Start button

Taskbar icon
Taskbar

Notification area
Date and Time

Start Menu

Icons

Icon is a picture or symbol that appears on a monitor and is used to 
represent a command, as a file drawer to represent filing. Icons are 
very useful in applications that use windows, because with the click 
of a mouse button you can shrink an entire window into a small icon. 
(This is sometimes called minimizing.) To redisplay the window, you 
merely move the pointer to the icon and click (or double click) a mouse 
button. (This is sometimes called restoring or maximizing). Icons are a 
principal feature of graphical user interfaces.
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Taskbar

The taskbar is a desktop toolbar application that lets you perform tasks 
such as switching between open windows and starting new applications. 
The taskbar is usually associated with the Microsoft Windows interface. 
The Windows taskbar has four main sections:
•	 Start Button (labeled with “Start” and the Windows logo)
•	 Quick Launch (allowing applications to be launched with a single 

click)
•	 Running Programs (allowing easy access to running programs)
•	 Notification Area (contains icons for small running programs such as 

the clock, calendar and volume control)

Start Menu

The Start Button starts programs, opens documents and provides access 
to the various parts of the system. Windows menu can be customized 
as needed.
All program 	 displays a list of the programs that are installed 

through Windows and available to use.
Documents 	 displays a list of the 15 documents recently used 

allowing the user to open them directly from 
this menu.

Settings 	 displays system components, such as printers, 
control panel and taskbar.

Find/Search 	 used to find files, folders and phrases in 
documents on the computer.

Help 	 displays textual information about certain topics 
related to computing.

Run 	 allows you to start a program from a command 
line.

Shut down 	 shuts down the computer, restarts the computer 
or logs you off from a network.
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Personalize Your PC

The Personalization Gallery is the place to get free wallpapers, 
languages, and themes. To personalize your desktop you have to open 
the Appearance and Personalization window. 
To open Personalization window, follow these steps:
•	 Click on Start button. The start menu will appear.
•	 Click on Control Panel. The Control Panel window appears. 

•	 Click on Appearance and Personalization. The Appearance and 
Personalization window appears.

•	 Click on Personalization. The Personalization window appears.
•	 Click on the Close button when you have finished working.

Facts Corner

The Control Panel in Windows 7 is the place to go when you need 
to make changes to various settings of your computer system. 
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Changing Desktop Background

Microsoft Windows 7 lets you change the desktop wallpaper on your 
computer to personalize it. You can use a digital photo, a solid color 
or frame a photo with solid color. Microsoft Windows 7 provides 
several default wallpapers you can choose from. You can also create 
a “slideshow” of pictures to alternate between your favourite desktop 
wallpapers.
To change desktop background, follow these steps:
•	 Click on the Start button located on the lower, left-hand corner of 

the screen.
•	 Click Control Panel to open the Microsoft Control Panel.
•	 Search for Desktop Background in the Control Panel.
•	 Select Change Desktop Background from the search results.

•	 Select the picture or colour you want to use as a desktop wallpaper. 
You can select multiple images for a slides if you want to automatically 
switch between photos for the wallpaper.

•	 Press Save Changes.
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Changing Screen Saver

A screen saver is an animated image that is activated on the screen when 
you do not use your computer for a period of time. Windows 7 includes 
a number of interesting screen savers which you can use to prevent 
passers-by from seeing what’s on your computer when you are away.
To change screen saver, follow these steps:
•	 Open the Start menu and type screen saver, then click Change 

screen saver from the results list.
•	 Click the pull-down menu below the screen saver label and select 

your preferred screensaver from the list.

•	 Click Preview to preview your screensaver. This verifies you have 
the proper screensaver selected.

•	 Type a number in the Wait field below the screensaver selection 
menu. This is the number of minutes the system must be idle before 
the screensaver is displayed.

•	 Click OK to save and activate the changes to the screensaver 
configuration.
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Applying Theme

A theme is a combination of pictures, colors, and sounds on your 
computer. It includes a desktop background, a screen saver, a window 
border color, and a sound scheme. Some themes might also include 
desktop icons and mouse pointers.
To apply theme, follow these steps:
•	 Click on the Start button located on the lower, left-hand corner of 

the screen.
•	 Click Control Panel to open the Microsoft Control Panel.
•	 In the search box, type personalization, and then click 

Personalization.Scroll down to view the available themes.
	 Aero Themes use transparency effects, color intensity, and high 

resolution background images.
	 Basic and High Contrast use simple effects or high-contrast effects.
•	 Click on the theme you want to use. Windows 7 applies the specified 

theme.	
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Change Your Color Scheme

The Windows 7 operating system includes a graphical interface made up 
of various colors, such as twilight, slate, lime, sun, fuchsia, frost, ruby 
and sea. The Windows 7 operating system selects some combination of 
these colors by default. 
To change your Color Scheme, follow these steps:
•	 Click Start, Control Panel, type window color in the search box and 

click Change window glass colors.
•	 Click Advanced Appearance Settings. The Window Color and 

Appearance screen opens.

•	 Select the item whose color you wish to modify from the Item drop-
down menu and then select the corresponding color from the Color 
1 drop-down menu. 

•	 Click Apply and then click OK.
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Desktop	 :	 The background area of your 
screen.	

GUI 	 :	 A way of allowing users to 
communicate with a computer that 
makes use of icons and pull-down 
menus.  

Icons	 :	 Small pictures that display programs.
Window	 :	 A rectangular area in which the 

contents of a program or a document 
are displayed.  

Tricky Terms 

•	 Windows is the name of an operating system developed by 
Microsoft Corporation, USA.

•	 Windows 7 is a Graphical User Interface (GUI) in which all the 
items are represented in the form of pictures and graphical links. 

•	 Desktop is a work area in Windows. 
•	 Icons are the small pictures that appear on the Desktop.
•	 A small arrow on the computer screen, which moves with the 

movement of the mouse, is a mouse pointer.
•	 Taskbar icons are the icons through which you can launch some 

Windows 7 features with just a mouse click.
•	 Notification area displays small icons that notifies you about the 

things that are currently happened on the computer. 
•	 The Personalization Gallery is the place to get free wallpapers, 

languages, and themes.

Let 
Us Revise
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Chapter Review
1.	 Fill in the blanks. Choose the answer from the clue box.

Clue  Box
Notification Area , personalization Gallery, pointer, Icons, 
Operating system

a.	 ___________________is a software which helps to operate and 
control the overall activities of a computer.

b.	 _______________are the small pictures that appear on the Desktop.
c.	 A small arrow on the computer screen, which moves with the 

movement of the mouse, is a_________________________.
d.	 _________________displays small icons that notifies you about the 

things that are currently happened on the computer. 
e.	 The___________________is the place to get free wallpapers, 

languages, and themes.

2.	 Match each term with the statement that best describes it.
Screen saver	 The background area of your screen.	
Icons	 A combination of pictures, colors, and sounds on 

your computer. 
Window	 Small pictures that display programs.
Theme		 A rectangular area in which the contents of a program 

or a document are displayed.
Desktop 	 An animated image that is activated on the screen when 

you do not use your computer for a period of time.   

3.	 Say whether these sentences are True or False.
a.	 Windows 7 is a Graphical User Interface (GUI) in which all items 

are represented in the form of graphics.
b.	 A small arrow on the computer screen, which moves with the 

movement of the mouse, is a cursor. 



47Computer Zone - Book 4

Lesson Labs

a.	 Start Windows on your computer. Double click on the My Computer 
icon on the desktop to open the My Computer window. Note down the 
names of different icons present in it.

b.	 Visit your computer lab and apply the steps to change the background 
setting, the screen saver and applying themes.

c.	 Save your photograph on your school computer and set it as wallpaper 
on the desktop.

c.	 The Personalization Gallery is the place to get free wallpapers, 
languages, and themes. 

d.	 A theme is an animated image that is activated on the screen when 
you do not use your computer for a period of time.

e.	 The Windows 7 operating system includes a graphical interface 
made up of various colors, such as twilight, slate, lime, sun, fuchsia, 
frost, ruby and sea.

4.	 Answer the following questions.
a.		 What is Microsoft Windows?
b.	 What do you mean by “Desktop”? 
c.	 What are icons? Write the names of any three icons found on the 

Desktop.
d.	 What is the function of the Taskbar?
e.	 What is a Personalization Gallery?
f.	 Which theme uses simple effects or high contrast effects?

5.	 Write the full form of the following.
	 GUI     		    UPS	   		  OS   		       PC
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•	 Explain the use of graphics software.
•	 	Define Paint and explain the use of color boxes.
•	 	Identify and explain the use of various tools in Paint.
•	 	Explain the advanced features of Paint.

Chapter6

Learning Objectives

An  Overview
Graphic software is a kind of software 
which is usually used to manipulate 
visual images or creating, editing and 
managing 2D computer graphics. These 
computer graphics include clip arts, 
web graphics, digital photos, logos, 
backgrounds and headings. PAINT is a 
simple graphic program that you can use 
to create drawings on a blank canvas or 
on top of other pictures. It is located in 
Accessories.  This is done by using the 
various tools and colours present in the 
Paint program. 

More Fun in
Paint
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Starting Paint Program

Let us see how to get into the colourful world of PAINT. Switch ON the 
computer. Your monitor displays Windows Desktop. Windows Desktop 
has a Start button on the bottom left corner. 
a.	 Click on the Start button.
b.	 Click on All Programs.
c.	 Select Accessories. You will notice a list of options.	
d.	 Click on Paint. The Paint window appears on the screen.

Color Boxes

The Color boxes indicate the current Color 1 (foreground color) and 
Color 2 (background color) colors.
The Color 1 box shows the active colors or foreground color. To change 
the foreground color, click on Color 1 box and then click on the desired 
color palette.
The Color 2 box is the background color. The background color is the 
default color of any new image that you create. To change the background 
color, click on Color 2 box and then click on the desired color in the 
Color palette.
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Tools in Paint

Paint contains a different tools to draw and insert shapes into your 
drawing. The different types of tools in Paint are: 
Pencil Tool 	 It is used to draw 

straight, wavy and 
curved lines. It is 
used as a normal 
pencil. Freehand 
drawing can be 
done using this 
tool.

Eraser Tool 	 This tool is just 
like your normal 
eraser which is used to erase a drawing or a 
part of it.

Brush Tool	 The brush tool is used for drawing freehand 
drawings using coloured brush.

Line Tool 	 The line tool is used to draw horizontal, 
vertical or slanting or straight lines of different 
thickness.

Rectangle Tool 	 The rectangle tool is used for drawing 
rectangles or squares. 	

Circle Tool 	 The circle tool is used for drawing oval shapes 
and circles.

Rounded Rectangle Tool	The rounded rectangle tool is used for drawing 
rectangles with rounded corners.

Polygon Tool	 The polygon tool is used for drawing 
polygons.	

Curve Tool	 The curve tool is used to draw curved shaped 
objects.

Text Tool 	 The text tool is used to write text on the Paint 
screen. 
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Resize and Skew

Resize command is used to change the size of the drawing by making it 
taller or shorter. Skew command is used to twist the drawing.
Resizing an image
a.	 Click on Home tab.
b.	 Click on Select.
c.	 Select the image by dragging the mouse over it.
d.	 Click on Resize. Resize and Skew dialog box appears.

e.	 Select the Maintain aspect ratio check box.
f.	 Select the radio button of pixels.
g.	 Type the horizontal value (width) or vertical value (height).
h.	 Click on OK. The new size of the image appears.
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Skew an image
a.	 Click on Home tab.
b.	 Click on Select.
c.	 Select the image by dragging the mouse over it.
d.	 Click on Resize. Resize and Skew dialog box appears.

e.	 Type the amount of skew in the Horizontal and Vertical boxes.
f.	 Click on OK. The skew of the image appears.
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Flip and Rotate

Paint allows you to flip or rotate your drawing. Flip command is used 
to create a mirror image of the picture either horizontally or vertically. 
Rotate command is used to change the position of image at different 
angles.
a.	 Click on Home tab.
b.	 Click on Select.
c.	 Select the image by dragging the mouse over it.
d.	 Click on Rotate. Rotate and Flip options appears.

e.	 Click on rotation direction you want.  

Erasing part of a picture
The Eraser tool is used to erase areas of your picture.
•	 On the Home tab, in the Tools group, click the Eraser tool.
•	 Click Size, click an eraser size, and then drag the eraser over the area 

of the picture that you want to erase. Any areas that you erase will 
reveal the background color (Color 2).
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Crop Image

The Crop tool is used to crop a picture so only the part you selected 
appears in your picture. Cropping lets you change the picture so only 
the selected object or person is visible.
a.	 Click on Home tab.
b.	 Click on Select.
c.	 Select the image by dragging the mouse over it.
d.	 Click on Crop. Only the selected part of the image appears.

Copy and Paste

Copying image allow you to make duplicate image in the drawing area. 
It can save your time by not drawing the same image again and again. 
The Copy and Paste command is used to copy the image from one place  
and paste it at another place.
a.	 Click on Home tab.
b.	 Click on Select.
c.	 Select the image by dragging the mouse over it.
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d.	 Click on Copy. 
e.	 Click on Paste. The duplicate image appears in the drawing area.
f.	 Now place the mouse pointer on the selected image and drag it to 

anywhere in drawing area.

Cut and Paste

The Cut command removes the selected data from its original position. 
paste it at another place.
a.	 Click on Home tab.
b.	 Click on Select.
c.	 Select the image by dragging the mouse over it.
d.	 Click on Cut. 
e.	 Click on Paste. The image appears in the drawing area.
f.	 Now place the mouse pointer on the selected image and drag it to 

anywhere in drawing area.
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Zoom In and Zoom Out

The Zoom in and Zoom out is used to see a larger or smaller view of 
your image. For example, you might be editing a small part of it and 
need to zoom in to see it. Or the opposite might be true; your picture 
might be too large to fit on the screen, so you need to zoom out to view 
all of it.
In Paint, there are few different ways to zoom in or out, depending on 
what you want to do.
a.	 To increase the zoom level, on the View tab, in the Zoom group, 

click Zoom in.
b.	 To reduce the zoom level, on the View tab, in the Zoom group, click 

Zoom out.
c.	 To view the picture in the Paint window at its actual size, on the 

View tab, in the Zoom group, click 100%.

Saving and Opening your picture

Save a picture for the first time
When you save a new picture for the first time, you’ll need to give it a 
file name.
a.	 Click the Paint button, and then click Save.
b.	 In the Save as type box, select the file format you want.
c.	 In the File name box, type a name, and then click Save. 

Open a picture
Instead of starting with a new picture, you might want to open an existing 
picture and edit in Paint.
a.	 Click the Paint button, and then click Open.
b.	 Find the picture you want to open in Paint, click it, and then click 

Open. 
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Graphic software	 :  		A kind of software which is usually 
used to manipulate visual images 
or creating, editing and managing 
2D computer graphics.

PAINT 	 :	 A simple graphic program that 
you can use to create drawings on 
a blank canvas or on top of other 
pictures. 

Flip command 	 :	 The command used to create 
a mirror image of the picture 
either horizontally or vertically. 

Crop tool 	 :	 The tool used to crop a picture so 
only the part you selected appears 
in your picture.

Tricky Terms 

•	 Graphic software is a kind of software which is usually used to 
manipulate visual images or creating, editing and managing 2D 
computer graphics. 

•	 PAINT is a simple graphic program that you can use to create 
drawings on a blank canvas or on top of other pictures.

•	 The Color boxes indicate the current Color 1 (foreground color) 
and Color 2 (background color) colors.

•	 Resize command is used to change the size of the drawing by 
making it taller or shorter. 

•	 Paint allows you to flip or rotate your drawing. 

Let 
Us Revise
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Clue  Box

Pencil, Crop, Graphic software, Flip, Rectangle 

a.		 _____________________is a kind of software which is usually 
used to manipulate visual images or creating, editing and managing 
2D computer graphics.

b.	 The_____________tool is used to draw straight, wavy and curved 
lines.  

c.	 The_______________tool is used for drawing rectangles or squares. 
d.	 _______________command is used to create a mirror image of the 

picture either horizontally or vertically. 
e.	 The________________tool is used to crop a picture so only the part 

you selected appears in your picture.  

2.	 Say True or False for the following statements.
a.	 PAINT is a simple graphic program that you can use to create 

drawings on a blank canvas or on top of other pictures.  
b.	 The Eraser tool is used for drawing freehand drawings using coloured 

brush.
c.	 Resize command is used to change the size of the drawing by making 

it taller or shorter.
d.	 Rotate command is used to create a mirror image of the picture 

either horizontally or vertically.  
e.	 The Zoom in and Zoom out is used to see a larger or smaller view of 

your image. 

Chapter Review
1.	 Fill in the blanks. Choose the answer from the given words.
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3.	 Answer the following questions.
a.	 What is a graphic software? 
b.	 What is Resize and Skew commands used for?
c.	 What is the difference between Flip and Rotate command?
d.	 What is the difference between Copy and Cut commands?
e.	 Why do we use Zoom tool?

Lesson Labs

Visit your computer lab, open Paint and try to draw car:

a.	 Select any part of the drawing, cut and paste it in another place.
b.	 Flip and rotate the image.
c.	 Resize the image by making it taller.
d.	 Save and close the image.
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•	 	Define word processing and explain the importance of word 
processor.

•	 	List the important advantages of Microsoft Office Word 2010.
•	 	Explain the various steps to beautify a document.

Chapter7

Learning Objectives

An  Overview
Word processing means using a computer 
to create, edit and print documents. These 
documents can be letters, reports, articles, 
essays, poems, etc. It allows you to:
a.	 Write text-(letters, words, sentences 

or paragraphs.
b.	 Edit text - making corrections.
c.	 Format text - to change the style, 

colour and size of the text as required.
d.	 Save document - for use in future.
The most popular word processing 
software is Microsoft Word.

Microsoft Office
Word 2010
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Microsoft Office Word 2010

Microsoft Office Word 2010 is one of the most 
widely used software packages under Windows 
environment. It is developed by Microsoft 
Corporation, USA. It is a window based word 
processor which can create documents such as 
letters, memos, newsletters and brochures.
Microsoft Word has the following advantages:
•	 It allows to edit a document.  
•	 It allows to change the appearance of the document.
•	 It allows you to insert clipart in a document.
•	 It allows you to set the margins.
•	 It allows to add borders and shadings in a document. 
•	 It allows you to print text by using many of thousand typefaces, 

commonly called fonts. 
•	 It creates customized letters to a form letter and a list of names and 

addresses.

expanding 
your horizons

Microsoft Office 2013 (formerly Office is a 
version of Microsoft Office, a productivity suite 
for Microsoft Windows. It is the successor of 
Microsoft Office 2010 and includes extended 
file format support, user interface updates and 
support for touch among its new features.
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Starting Word 2010

Windows must be running to start Word. Follow the steps to 
open Word 2010.
•	 Click on the Start button.
•	 Click on All Programs.
•	 Click on Microsoft Office. 	
•	 Click on Microsoft Word 2010. 
The Microsoft Word will appear. An empty document titled Document1 
appears on your screen.

The major components of the default window are:
Title bar		  The title bar displays the name of the 

program (Microsoft Word) and the active 
document name.

Quick Access Toolbar	 The quick access buttons contains the 
options such as save, undo and redo.

File Tab		  Under the Quick Access Toolbar, File Tab 
is at the left side and labelled as File. It 
contains the File menu option such as save, 
save as, open and close files.



63Computer Zone - Book 4

Ribbon		 It is an interface where a set of toolbars are 
placed on tabs in a tab bar. 

Ribbon tab	 Each tab provides a set of tools related to an 
overall task you are likely to be performing 
in a specific application.

Insertion Point	 A blinking line on the working area of a 
window is an insertion point. It indicates 
the position where the text typed will 
appear.

Workspace		 The workspace currently displays a blank 
document window, which is maximized 
and occupies the entire space.

Scroll bar		 The scroll bar is used to show the different 
area of the active document.

Status bar		 The status bar displays location information 
and the status of different settings as they 
are used.

Exploring a File Tab

File Tab is main tab of Word 2010 that shows the Backstage view. 
Backstage view is a new feature in Word 2010. In the Backstage, the file 
information can be managed like save, share, print, protect and work 
with version information for document. 

Click on File Tab. A 
new screen will appear, 
displaying the most 
commonly used file 
management commands.
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The Backstage panel that appears is organized in three panels: the left, 
center and right panel.
•	 The left panel shows the commands that are used to work with the 

files created.
•	 The center panel offers related options and,
•	 The right panel displays an additional options.

Ribbon

The ribbon offers an easy way to locate commands that accomplish 
various program tasks. The Ribbon is grouped into tabs, and each tab 
holds a set of related commands.
•	 Click on a tab. The tab opens and organizes the tasks and commands 

into logical groups.
•	 Click on a button to activate a command or feature. Buttons with 

arrows displays additional commands.
•	 You can click on the corner arrow button to display a dialog box of 

additional settings.

Ribbon
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Creating a New Document

When you start Word, it opens automatically a new document. This 
document has a name Document1. You can straight away start typing in 
the empty document window. If you have already started the Microsoft 
Word and wish to open a new document, you can perform the following 
steps.
To create a new document, do the following:	
a.	 Click on File tab. Backstage view will appear.
b.	 Click on the New button.
c.	 Click on Blank Document in the Templates list. Sample View of 

your selected document appears in this area.
d.	 Click on Create. The new document file opens, and you can start 

adding your own data.
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Entering the Text

When you start Microsoft Word, a blank document appears with the 
name Document1 in the title bar.  You can begin typing in the empty 
document window. In a new document, the program places a blinking 
vertical bar in the upper left corner of the document window. As you 
type, the insertion point advances across the screen, showing you where 
the next character will be placed. When the insertion point reach the 
end of a line, Word automatically moves the text to the next line. This is 
known as word wrap. Press Enter to begin a new paragraph.
To enter the text, do the following:	
a.	 Type the first line of text.
b.	 To start a new paragraph, press Enter.
c.	 Type the remaining text.
d.	 Press Enter only when you want to start a new line or paragraph. 
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You can easily add new text to your document and remove text you no 
longer need.
To edit the text, do the following:	
a.		 Click on the location where the text is to be inserted.	
b.		 Type the text you want to insert.
c.		 Press Spacebar to insert a blank space.
d.		 Select the text you want to delete.
e.	 Press Delete key on your keyboard to remove the text.

Editing the Text

Microsoft Word requires the text selection before performing any 
operation on it. You can select a text by clicking it with a mouse or a 
keyboard. After selecting a text, you choose the action that you want to 
carry out on the text.
To select the text, do the following:	
a.		 Place the cursor on the position from where you want to start 

selecting the text.
b.		 Press the left mouse button.
c.		 Drag the mouse over the text to be selected.
d.		 Release the left mouse button. The text gets selected.	

Selecting the Text
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The Copy and Paste commands of Microsoft 
Word can be used to copy text from one location 
in a document and paste it to another location. 
The Copy command creates a duplicate of the 
selected text, leaving the original text unchanged. 
The Paste command pastes the copied text at the 
position where the cursor is.	
To copy the text, do the following:	
a.		 Select the item you want to move or copy.
b.	 Click Copy button on Clipboard panel of the Home tab. 
c.	 Position the insertion point at the location where you want to paste 

the text.
b.	 Click Paste button.

Copying the Text

Fast Forward

Press CTRL + X for cutting the text and press CTRL + V for pasting the text.

You can move text from one position in a document to the other using 
the Cut and Paste commands of Word. The Cut command deletes the 
selected text from its original position. The Paste command then places 
this text at the position where the cursor is placed.	
To move the text, do the following:	
a.		 Select the item you want to move or copy.
b.	 Click Cut button on Clipboard panel of the Home tab. 
c.	 Position the insertion point at the location where you want to paste 

the text.
d.	 Click Paste button.

Moving the Text
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Microsoft Word provides you with a huge variety of fonts to use in your 
documents. Font refers to a set of characters with a specific design. 
The default font in Microsoft Word is Times New Roman. You can 
improve the appearance of your document by changing the design of 
characters.	
To change font to the text, do the following:	
a.		 Select the text you want to change to a different font.
b.	 Click on Home tab on the ribbon.
c.	 Click on the down arrow of Font.
d.	 Click on the font you want to use.
	 The text you have selected changes to the new font.
	 To deselect text, click on outside the selected area.

Changing the Font Type

Font size refers to the height and width of the characters. It is measured 
in points, abbreviated “pt”. One point equals to 1/72 inch and the size 
of the text in most of the documents is 10 pt or 12 pt. You can increase 
or decrease the size of text in your document.
To change the size of text, do the following:	
a.		 Select the text you want to change to a different font.

Changing the Size of the Text
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b.	 Click on Home tab on the ribbon.
c.	 Click on the down arrow of Font Size.
d.	 Click on the size you want to use.
	 The text you have selected changes to the new size.

Microsoft Word offers different font styles such as bold, italic and 
underline. Bold character displays thicker and darker character than those 
that are not bold. Italicized text has a slanted appearance. Underlined 
text prints with an underscore ( _ ) below each character. Underlining 
is used to draw attention to specific text. You can apply font styles to 
improve the appearance of the text.
To change the font style of text, do the following:	
a.		 Select the text you want to change to a different font.
b.	 Click on Home tab on the ribbon.
c.	 Click on the down arrow of Font Style.
d.	 Click on any style. Word applies style to the text. 

Changing the Font Style

Fast Forward

Press CTRL + B for boldface, 

CTRL + I for italic and CTRL + U for underline
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If you have a colour printer or is going to share the document 
electronically, you can add impact by adding some colour.
To change the font colour, do the following:	
a.		 Select the desired text.
b.	 Click on Home tab on the ribbon.
c.	 Click on the down arrow of Font Color.
d.	 Click on any color. Word applies color to the text.

Changing the Font Colour

Paragraph alignment refers to the way text is set with respect to the 
margins. There are four types of paragraph alignment styles. You can 
choose any one of the styles. These styles are: left alignment, right 
alignment, center alignment and justified.
To align the text, do the following:	
a.		 Select the paragraph you want to align differently.
b.	 Click on Home tab on the ribbon.
c.	 Click on the down arrow of Font Color.

Aligning the Text
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ClipArt refers to the picture files that can be inserted into a document 
to make it more interesting and communicative. These picture files are 
available through the Clip Gallery feature of Microsoft Word. The Clip 
Gallery also includes sound clips, video clips and motion clips.
To insert a clipart, do the following:	
a.	 Select the Insert tab.
b.	 Click the Clip Art command in the Illustrations group.
c.	 Enter keywords in the Search for: field that are related to the image 

you wish to insert.
d.	 Place your insertion point in the document where you wish to insert 

the clip art.
e.	 Click an image in the Clip Art pane. It will appear in the document. 
f.	 You can also click the drop-down arrow next to the image in the 

Clip Art pane to view more options.

Inserting a ClipArt

d.	 Click on one of the following buttons:
	 Click on the Align Left button to left-align the text.
	 Click on the Center button to center the text.
	 Click on the Align Right button to right-align the text.
	 Click on the Justify button to justify text between the left and right 

margins.
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The WordArt feature is used to enhance your documents by changing 
the shape of text and adding special effects such as 3-D and shadows. 
You can also rotate, flip and skew WordArt text. 	
To insert a wordart, do the following:	
a.	 Select the text  you want to convert into the WordArt.
b.	 Click on Insert tab.
c.	 Click on WordArt. A list of options will appear.
d.	 Click on the WordArt style you want to use. The WordArt appears 

in the textbox in your document.
e.	 Click outside the text box to hide the text box.

Inserting a WordArt

A document created, must be saved into the memory of the computer 
for future use.	
To save a document, do the following:
a.	 Click the File tab.
b.	 Click Save As.
c.	 In the File name box, enter a name for your document.
d.	 Click Save. 

Saving and Opening a document
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In Word 2010, a mini toolbar is available to get the quick access to 
common formatting command. A mini toolbar appears faintly whenever 
you select any text in the document. Its tools can be activated if you 
want to use this and if you don’t want to use it, you can continue with 
your working.
To use mini toolbar, do the following:	
a.	 Select the text  you want to format. The mini toolbar appears faintly.
	 You can also right-click over the selected text to display the toolbar.

Using Mini Toolbar

b.	 Move the mouse pointer over the toolbar and click on the tool that  
you want to activate.

	 Word immediately applies the formatting.
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Alignment  		  Refers to the way text is set with 
respect to the margins. 

ClipArt		  Ready made pictures.
Font		  A set of characters with a specific 

design. 
Word processor		 A software which are used for word 

processing.
Word wrap		  The automatic placement of word in 

the next line.

Tricky Terms 

•	 Word processing software (also called a word processor) is an 
application software that provides extensive tools to create, view, 
edit, format, store and print text materials for human communication.

•	 Microsoft Office Word 2010 is one of the most widely used software 
packages under Windows environment.

•	 File Tab is main tab of Word 2010 that shows the Backstage view. 
•	 The ribbon offers an easy way to locate commands that accomplish 

various program tasks. 
•	 The Copy and Paste commands of Microsoft Word can be used to 

copy text from one location in a document and paste it to another 
location. 

•	 Paragraph alignment refers to the way text is set with respect to the 
margins.

•	 In Word 2010, a mini toolbar is available to get the quick access to 
common formatting command. 

Let 
Us Revise
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Chapter Review
1.	 Fill in the blanks. Choose the answer from the clue box.

Clue  Box
File Tab, Ribbon, Word processing, Microsoft Word, Paragraph 
alignment

a.	 ___________________is an application software that provides 
extensive tools to create, view, edit, format, store and print text 
materials for human communication.

b.	 __________________is one of the most widely used software 
packages under Windows environment.

c.	 __________________is main tab of Word 2010 that shows the 
Backstage view. 

d.	 The_________________offers an easy way to locate commands 
that accomplish various program tasks. 

e.	 ____________refers to the way text is set with respect to the margins.

2.	 Match each term with the statement that best describes it.
Font  		 Refers to the way text is set with respect to the margins. 
Word processor		 Ready made pictures.
Alignment		  A set of characters with a specific design. 
Word wrap		  A software which are used for word processing.
ClipArt		 The automatic placement of word in the next line.   

3.	 Say whether these sentences are True or False.
a.		 Ribbon	 is an interface where a set of toolbars are placed on tabs in 

a tab bar.
b.	 The status bar is used to show the different area of the active 

document.
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c.	 The Copy and Paste commands of Microsoft Word can be used to 
copy text from one location in a document and paste it to another 
location.

d.	 The default font in Microsoft Word is Arial Black.
e.	 Paragraph alignment refers to the way text is set with respect to the 

margins. 

4.	 Answer the following questions.
a.	 What is a word processing software? Name some popular word 

processing software.
b.	 List any five advantages of Microsoft Office Word 2010.
c.	 What is insertion point?
d.	 What is a file tab?
e.	 What is the difference between moving and copying the text?
f.	 What is paragraph alignment?
g.	 What is the use of mini toolbar?

Lesson Labs

Open a new file in the Word 2010 and type a short story. Now perform the 
following formatting options.
a.	 	Bold and center the title “Fairy Tale”.
b.	 Change the title font to a font of your choice to 18 points.
c.	 Add a colour of your choice to the title text.
d.	 Change the font of entire document to Times New Roman.  
e.	 Save the document as Fairy Tale.
f.	 Close the document and exit Word 2010. 
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•	 Define a QBASIC.
•	 Identify the special features of QBASIC.
•	 Creating a program using QBASIC Editors.
•	 QBASIC Interface
•	 Elements of QBASIC Programming.
•	 Explain the function and syntax of simple QBASIC Statements.

Chapter8

Learning Objectives

An  Overview
The computer cannot think and make any decision on 
its own. It needs instructions to perform any task. A 
computer needs instructions in a language that it can 
understand. Such language is known as programming 
language. There are various types of programming 
languages.  Basic is one of the programming 
languages, which stands for Beginners’ All Purpose 
Symbolic Instruction Code. It was developed in 1964 
at Dartmount College, U.S.A. by Professor John 
Kemeny and Thomas Kurtz. It allows the usage of 
simple English like statements and mathematical 
operators. There are various versions of BASIC like 
TURBO BASIC,  GW-BASIC and QBASIC.

Introduction To QBASIC 
Programming 

Languages
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Starting and QBASIC Program

Feature of QBASIC

QBASIC is a high level computer programming language developed by 
Microsoft Company.It is more powerful programming language than 
otherTURBO BASIC and  GW BASIC  programming language.It has a 
powerful pull-down menu that can be driven by keyboard or mouse. It 
is easier for writing ,editing, running and debugging program.It can be 
used for scientific as well as commercial application.

QBASIC has many features some of the interesting features are given 
below:-
•	 QBasic is a high level language.
•	 It supports mouse and keyboard.
•	 Easy to learn and understand.
•	 It is easy to correct errors.
•	 QBasic editor checks syntax errors and capitalized QBasic reserved 

words.
Creating a Program Using the QBASIC Editor
The QBASIC interpreter software is needed to develop program using 
QBASIC language. You can start QBASIC from within windows or 
from DOS prompt:-

To start QBASIC from within windows follow these steps
Step 1: Locate the QBASIC folder.
Step 2: Double click on the QBASIC folder.
Step 3: Double click on the QBASIC or QB icon
Step 4: Press the ESC key to clear the dialog (Welcome) box.
Step 5: Start typing your program.
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To start QBASIC from the DOS prompt follow these steps
Step 1: open the Command prompt or DOS prompt.
Step 2: Go to the QBASIC directory using CD command.
	 C:\ CD QBASIC (then press inter key)
Step 3: Type QBASIC
	 C:\ QBASIC> QBASIC ( then press inter key)
Step 4: Press the ESC key to clear the dialog (Welcome) box.
Step 5: Start typing your program.

 Note:- Press Alt+ Enter key to increase the size of QBASIC window 
that fills the entire screen. Again, press Alt+ Enter key to reduce 
the size of maximized QBASIC window.

QBASIC The QBASIC interface has the following parts:-
1.	 Title bar
2.	 Menu bar
3.	 Current program
4.	 Name of the current program

QBASIC   Interface/parts
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5.	 Window to immediately execute a command
6.	 Status bar
7.	 Status of Caps Lock and Num Lock
8.	 Current line of cursor
9.	 Current column of the cursor

1.	 Title bar:-
	
	 The horizontal bar located at the top most part of the window is 

called Title bar. It shows the name of the program in which you 
are presently working. There are Minimize, Maximize and close 
buttons on the right side of the title bar.

2.	 Menu bar:-  

	
	 Menu bar lies below the title bar, it contain several menus like File, 

Edit, Search, Run, Debug, Options and Help. Each menu contains 
the different sub menu. The different sub menu of the menu is 
described below:- 

	 File:     
	 New- Clears the Current Program	  
	 Open- Loads a program from a disk	
	 Save- Saves the current program to the 

disk	
	 Save As- saves the program, under a 

different name at different location.	
	 Print- Prints the selected text, current window, or entire 

program	
	 Close the QBasic Interpreter	
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	 Edit:     
	 Cut- Removes the selected text and 

saves it in the clipboard.	 
	 Copy- Copies the text instead of 

removing it	
	 Past- Add the text in the clipboard to 

the current position of the curser.	
	 Clear-Removes the text without 

storing it to the clipboard.	
	 New Sub- Enables you to create a 

new subroutine.	
	 New Function- Enables you to create a new function	

	 View:     
	 SUBs-Shows the list of the current 

subrotines and functions.	 
	 Next SUB-It shows the sub 

module	
	 Split-Displays the contents of the 

current programs in two windows. 
If the window is already split, this 
hides the second window.	

	 Next Statement-It display the next statements	
	 Output Screen-Shows the QBasic output screen.	

	 Search:   
	 Find- Allows you to search for string 

of the text in the program.	  
	 Select text- It helps to select the 

text.	
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	 Repeat Last Find-Continues the previous search operation.	
	 Change- Replaces each instance of a string with another 

string.	
	
	 Run:   
	 Start- Execute the current program	  
	 Restart-  Again Start from the 

beginning	
	 Continue- Continues execution at the 

current position .	

	 Debug:   
	 Add Watch..- It helps to  add 

watch window	  	
	 Instant watch...-	
	 Toggle Breakpoint- Sets or 

removes a breakpoint. Using 
this QBasic interpreter stop 
when it reaches a specified line in the program.	

	 Clear All Breakpoint- Removes all breakpoints in the 
program.	

	 Options:   
	 Display- Enables you to change foreground 

and background colors, the number of 
space to use for tabs, and whether or not 
scroll bars are visible.	  

	 Set paths.. - It helps to set the path with 
extension of the file.	

	 Syntax Checking- Allows you to have the 
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QBasic editor check the syntax of your program as you type.	
	 Full Menus- Helps to show all the menus on the screen of 

QBasic.	
	
	 Help:   
	 Index- lists of all QBasic commands, 

keywords and operators.	 
	 Contents- The table of contents for 

QBasic help	
	 Topic- Show help for a specific 

keyword	
	 Help on Help- Shows information on 

using QBasic help	

3.	 Current program: - The current program is displayed in the 
middle of the screen, and covers most of the QBasic interface.

4.	 Name of the current program:-  The file name of the current 
program is displayed near the  top of the screen in the center. You 
can change the name by selecting “Save As” on the “File” menu.

5.	 Window to immediately execute a command:- The immediate 
window is located just below the view window and it’s used to 
execute statements as soon as they are entered. This window is 
often used as a calculator and a debugging tool. You can activate 
this window by pressing the F6 key and you can return to the view 
window by pressing the F6 key again.

6.	 Status bar:-The status line is located across the very bottom of the 
window and it displays a list of the most frequently used function 
keys. It will also indicate whether you have the CAPS LOCK key 
on, current line and current column.

7.	 Status of Caps Lock and Num Lock:- If Caps Lock is set a “C” 
is displayed on the right side of the status bar. If Num Lock is set 
“N” is displayed on the right side of the status bar.
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8.	 Current line of Cursor:- On the right side of the status bar, the 
current line of the cursor is displayed.

9.	 Current column of the cursor:- On the right side of the status 
bar, the current column of the cursor is displayed.

Creating a New program File

 To create a new program file you should follow the following steps:
Step1	 :	 Click on File menu and click on the New program command 

as shown in figure.

You can directly write a program in the QBasic screen by following 
QBasic protocol:-
PRINT “ wel come to you in  QBasic programming”;

Writing a  First Program

Running or   Executing the Program

After writing a program code, it should be executed to get the output.
Step1	 :-	 Open the Run menu.
Step 2 	 :-	 Select the Start command.
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Or use the short cut key i.e. press F5 keys from Keyboard

This is the output screen of above coding:-

QBasic allows you to save the current program onto the disk for future 
use. To save your tasks go through the following steps:-
Step 1 :-	 Click on the file menu and then click on the save as command. 

Then a save dialog box appears.
Step 2:- 	 Type the file name on the File Name Box
Step 3:- 	 Click on OK button.

Note
While giving the file name we should considered the following points.
•	 The file name should begin with an alphabet.
•	 Any special characters are not allows in the file name.
•	 The file name can be given up to 8 characters long.
•	 The blank space is not allows in the file name.
•	 The extension of QBasic file is BAS it will appears automatically.

Saving a   Program
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Opening the  Saved  Program

To open your saved tasks go through the following steps:-
Step 1:-		 Click on the file menu and then click on the Open program 

command
Then a Open dialog box appears.
Step 2:- 	 Type the file name on the File Name Box
Step 3:- 	 Click on OK button.

Brainstorming 

  task
Fill in the blanks. 
a.	 _____________ is a set of instruction that performs specific task 

in the computer.
b.	 BASIC was developed by ___________ in ___________ A.D
c.	 QBASIC is ____________ level programming language.
d.	 BASIC stands for _____________ .
e.	 To save the program ____________ key is pressed.
f.	 To run the program ____________ key is pressed.
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Elements of QBASIC Programming

The important elements of QBASIC programming consists of the character 
set, variables, constants, operators, expressions keywords.

Character Set
The character set is a set of symbols used to frame the various components of 
a program. The character set consists of digits, letters and special characters 
that are valid in QBASIC. The character set includes:
Alphabets	 :	 A to Z (small and capital letters)
Numbers	 :	 0 to 9
Special	 :	 ;  = + -* / ^ ( ) % $ #! ,
characters	 :	 .’ “ :& ? < > \ - b 
			   (Note: The symbol b denotes a blank space.)

Variables
Variables are programmer-defined areas in the computer memory for storing 
data. When programmers talk of computer memory, it is usually RAM to 
which they are referring. All variables are created in RAM. The data stored 
in a variable can change during the execution of the program.

Variable-Naming Conventions
Variable names need to follow certain rules and standard naming conventions 
of QBASIC. Given below are certain points to remember when naming a 
variable:	
•	 The names may be up to 40 characters long.
•	 The characters allowed in a variable names are letters, numbers, the 

decimal point and the special type declaration characters ($, %, #, &, 
and !).

•	 The first character in the variable name must be a letter.
•	 Reserved words of QBASIC cannot be used as variable names.
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Types of Variable	
Variables are of two types - numeric variable and string variable depending 
on the kind of data item they represent.
•		 Numeric Variable
		 A numeric variable has a number as its value. It must begin with an 

alphabet and the remaining characters, if used, may be alphabets or digits 
or both. The valid numeric variables are A2 and B.	

•	 String Variable
	 The string variable has a character or string of characters as its value. 

It must begin with an alphabet and end with a dollar($) sign. The valid 
string variables are A$, B3$, C$ and TL$.	

Constants
Constants are data items whose values do not change while the program 
is running. There are two types of constants: numeric constant and string 
constant.  
•	 Numeric Constant
	 Numeric constants are positive or negative numbers on which 

mathematical operations such as addition, subtraction, multiplication 
and division can be performed. Numeric constants should not contain 
commas. The valid numeric constants are 150, -980, +76 and 129.

•	 String Constant
	 A string constant is a set of alphanumeric or special characters enclosed 

within double quotes. Blank spaces can also be used in a string. The 
valid string constants are “Fun with BASIC” and “Enjoy Programming”.

Solved Example

A = 20	 ‘A is a numeric variable and 20 is a numeric constant”
PRINT A	
END
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Operator
An operator is a symbol representing the operations they perform on operands 
in a program. The values on which the operator’s work are referred to as 
operands. It is used to compute, compare values and test multiple conditions. 
The operators in QBASIC are classified as follows:
a. 	 Arithmetic operators	 b.  Relational operators
c. 	 Logical operators	 d.  String operator

a.		 Arithmetic Operators
		 Arithmetic operators are used to perform various mathematical operations.  

The general format of arithmetic operator is:	  
	 operand1 arithmetic_operator operand2 
	 The arithmetic operators supported by QBASIC are: 
	 Operator	  Name	 Example
	 +	 Addition	 A + B
	 -	 Subtraction	 A - B	
	 *	 Multiplication	 A*B	
	 /	 Division	 A/B
	 \	 Integer Division	 A\B
	 Mod	 Modulus	 A mod B
	 ^ 	 Exponential	 A^B

Solved Example

REM “The program to illustrate the use of arithmetic operators”
a = 15 : b = 5
PRINT “The difference is=”;a-b
PRINT “The sum is=”;a+b
PRINT “The product is= ”;a*b
PRINT “The quotient is= ”;a/b
END
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b.	 Relational Operators
		 Relational operators are used to compare two values of same type, either 

both numeric or both string. The general format of relational operator is: 
	 operand1 relational_operator operand2
	 The relational operators supported by QBASIC are:
	 Operator	  Name		  Example
	 =	 Equal		  A=B
	 <	 Less than		  A<B
	 >	 Greater than		  A>B
	 <=	 Less than or equal to		  A<=B
	 >=	 Greater than or equal to	 A>=B
	 <>	 Not equal to		  A<>B

b.	 Logical Operators
	 Logical operators are used to connect two or more relational expressions 

to evaluate a single value as True or False. The general format of logical 
operator is:

	 operand1 logical_operator operand2
	 The logical operators supported by QBASIC are:
	 Operator	  Name			   Example
	 AND	 Evaluates to true when both		  A > B AND
			  conditions are true			   A > C
	 OR	 Evaluates to true when one		  A > B
			  or both conditions are true		  OR  A > C
	 NOT	 Makes a true expression false, 	 A  NOT  B
			  and a false expression true.

Assume  x=5 and y=6. What will be stored in result in each of the 
following statements?
Expression	 Result
(x<7) AND (y>7)	 True AND False => False

Solved Example
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a.		 String Operator
	 The joining of two or more strings is called concatenation of strings. The 

strings are connected by the string operator, which is the plus sign (+). 
For example, the statement:

	 PRINT “KATH” + “MANDU”
	 would cause QBASIC to display the following string.	
	 KATHMANDU

First Look at QBASIC statements

A statement is a group of BASIC keywords generally used in program lines 
as part of a program. These statements are first stored in the memory of 
the computer and executed only when the command RUN is given. It is 
either executable or non-executable. Executable statements are program 
instructions that tell BASIC what to do during the execution of a program. 
Non-executable statements do not cause any program action. In this section, 
we shall discuss simple programming statements.

REM statement
The REM statement is the short form of ‘remarks’. The computer ignores 
anything following the word REM and it is used to put explanatory notes 
in the program. You may use a single quotation mark ( ‘ ) instead of REM. 
The general form of the REM statement is: 
REM <Any Text>

Solved Example

REM  “My first QBASIC program”
LET price = 200
LET tax = price * 25 / 100
PRINT “The sales tax is::”; tax
END
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CLS statement
The CLS statement clears the screen. It is used whenever a fresh screen is 
desired during the program execution. The general form of the CLS statement 
is: 
CLS

Solved Example

CLS
PRINT “Programming is great fun”
END

LET statement
The LET statement is used for storing a value in a variable. The word LET is 
optional, i.e., the equal to sign is sufficient when assigning an expression to a 
variable name. The general form of the LET statement is:			     
LET <variable> = <variable or constant or expression>

Solved Example

REM “Program to find the sum of two numbers”
LET a = 20
LET b = 30
Sum = a + b
PRINT “The sum of the two numbers::: ”; Sum
END

INPUT statement
The INPUT statement is used to accept input from the keyboard during 
program execution. It facilitates the use of same program for various sets of 
data to obtain different results in different executions. The general form of 
the INPUT statement is:	
INPUT <“message”> ; variables
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Solved Example

REM “This program finds the area of a rectangle”	
CLS
INPUT “Enter the length of a rectangle”; l
INPUT “Enter the width of a rectangle”; w
Area = l * w
PRINT “The area of the rectangle is:::”; Area
END

PRINT statement
The PRINT statement is used to display data or the results of calculation on 
the screen. Question mark (?) may be used in place of the word ‘PRINT’. 
The general form of the PRINT statement is:	
PRINT <variable, constants or expressions> 

Print Positions
BASIC divides the line into print zones of 14 spaces. The position of each 
item displayed on the screen is determined by the punctuation used to separate 
the items in the list. The separator and print position is described below: 
Separator		  Print Position
	 ,		  Zone wise 	
	 ;		  Side by side
	 space(s)	 Immediately after the last value	

END statement
The END statement denotes the end of the program. Once the program 
encounters the END statement, the computer stops processing any further as 
it has reached the termination point. It must be written as the last statement 
in every program. The general form of the END statement is: 
END
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QBASIC	 :  	 A high level computer language 
developed by Microsoft in 1985.

Character set	 :	 A set of symbols used to frame 
the various components of a 
program.  

Variables 	 :	 The programmer-defined areas in 
the computer memory for storing 
data.  

Constants	 :	 The data items whose values do 
not change while the program is 
running. 	

Operator	 :	 A symbol representing the 
operations they perform on 
operands in a program. 

Tricky Terms 

Let 
Us Revise

•	 QBASIC is a high level computer language developed by Microsoft in 
1985. 

•	 The character set is a set of symbols used to frame the various components 
of a program. 

•	 Variables are programmer-defined areas in the computer memory for 
storing data.

•	 Constants are data items whose values do not change while the program 
is running.

•	 An operator is a symbol representing the operations they perform on 
operands in a program. 

•	 The joining of two or more strings is called concatenation of strings.
•	 A statement is a group of BASIC keywords generally used in program 

lines as part of a program. 
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Solved  Exercise

A.	 Write a program that calculates the area of rectangle.

Program code:-

CLS

INPUT “enter the length of 

rectangle”;L

INPUT “enter the breadth 

of rectangle”;B

A = L * B

PRINT “The area of a 

rectangle is”;A

END

B. 	Write a basic program to input the  height and base and find out the 
area of triangle.
CLS

INPUT “enter the 

height”;H

INPUT “ente the 

breadth”;B

area = 1 / 2 * (H * B)

PRINT “The area of 

triangle is”; area

END
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C. 	 Write a program to calculate the simple interest.

CLS

INPUT “enter the 

principle”;p

INPUT “enter the rate”;r

INPUT “enter the time”;t

si = (p * t * r) / 100

PRINT “The simple 

interest is”;si

END

Chapter Review
1.	 Fill in the blanks.

Clue  Box
PRINT, INPUT, CLS, REM, LET

a.	  __________________is used to put explanatory notes in the program.  
b.	 ___________________is used whenever a fresh screen is desired during 

the program execution.
c.	 The______________________statement is used for storing a value in a 

variable.
d.	 The_____________________statement is used to accept input from the 

keyboard during program execution.
e.	 The________________________statement is used to display data or the 

results of calculation on the screen. 
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2.	 Match the followings.
	 Variables		 A high level computer language developed by 

Microsoft in 1985.
	 Operator		 A set of symbols used to frame the various 

components of a program.  
	 QBASIC 		 The programmer-defined areas in the computer 

memory for storing data.  
	 Character set		 The data items whose values do not change while 

the program is running. 	
	 Constants		 A symbol representing the operations they perform 

on operands in a program.  

3.	 Say whether these sentences are True or False.
a.	 BASIC allows the usage of simple English like statements and 

mathematical operators. 
b.	 The numeric variable must begin with a number and the remaining 

characters, if used, may be alphabets or digits or both. 
c.	 Reserved words of QBASIC cannot be used as variable names.
d.	 The string constant is a set of alphanumeric or special characters enclosed 

within single quotes.
e.	 Operator is a symbol representing the operations they perform on 

operands in a program. 

4.	 Answer the following questions.
a.	 What is a BASIC program?  Who developed BASIC?	
b.	 What are the important elements of QBASIC programming language?
c.	 What are variables and constants?
d.	 Differentiate between a numeric variable and a string variable.
e.	 What are operators? State the rules of logical operators.

5.	 Write BASIC expressions for the following algebraic expressions:
a.	 y = 6x			   b.  a = 2b+5c		  c.  y = x2 

d.	 nr2  + KT		  e.  (F - 32)2 			   f.  a2  + b2 
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6.	 Let x = 5, y = 8 and z = 10. What will be the value stored in result in each 
of the following statements?

a.	 r = x + y - z
b.	 r = (x * y) MOD z
c.	 r = z*y/x
d.	 r = (x+y)/z
e.	 r = (y/x)*z 

7.	 Examine the following program.
	 a = 2
	 b = 3000
	 PRINT “The first number is “;a
	 PRINT “The second number is “;b
	 END
	 List all the variables and constants that appear in the above program.

LAB SECTION

a.	 Create a new program file and type the following program code.
CLS
PRINT “WEL COME To YOU ALL”;
END
i. 	 Run this program.
ii. 	Save the program with appropriate file name.
iii.	Close the program
iv.	 Open the same file which you saved.
b.	 Write a QBASIC program to display your name in QBASIC Screen.
c.	 Write a program that calculates the area of rectangle. Hints Area=L×B
d.	 Write a program that calculates the volume of your class room. Hints 

volume = L×B×H
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Ty
ps

ha
la

Introduction

Touch typing is a commonly used system, which enables you to 
type quickly and accurately without looking at the keys. In order to 
know where your fingers are without looking, you must keep them 
positioned over their home keys, in the middle row of the keyboard.
Typshala is a typing tutor that provides free hand typing and entertains 
the user with a game.
To start typshala, follow these steps:
a. 	 Click on Start.
b. 	 Click on Typshala. Typshala program appears on the screen.
c.	 Click on Home.
d.	 Choose ‘Level 1’. 
e.	 Click on OK.
f.	 Choose writing script. 
g.	 Start typing.
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Lesson Exercise
a.	 Choose English Script from the Options menu.
b.	 Choose Lessons | Home Row | Level 1. Now, start typing
	

c.	 Choose Lessons | Home Row | Level 2. 

d.	 Choose Lessons | Home Row | Level 3. 
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Lesson Exercise 2
a.	 Choose English Script from the Options menu.
b.	 Choose Lessons | Top Row with Home Row | Level 1. Now, start typing
	

c.	 Choose Lessons | Top Row with Home Row | Level 2 

d.	 Choose Lessons | Top Row with Home Row | Level 3
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Lesson Exercise 3
a.	 Choose English Script from the Options menu.
b.	 Choose Lessons | Bottom Row with Home Row | Level 1. Now, start typing
	

c.	 Choose Lessons | Top Row with Home Row | Level 2 

d.	 Choose Lessons | Top Row with Home Row | Level 3




